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1 Introduction
This guide provides you with the following information:

• installation instructions for Nokia PC Suite 4.4

• instructions for using Nokia PC Suite 4.4

• wireless modem installation instructions for your Nokia 6360 phone

• configuring your data/fax software for digital data calls (using your Nokia 6360 phone as a wireless modem).

 • SYSTEM REQUIREMENTS
To install and run Nokia PC Suite 4.4, you need:

• Nokia 6360 phone

• an Intel-compatible PC running Windows 95 (OSR 2.x), Windows 98, Windows NT Workstation 4.0 with SP 5 or greater (cable 
only). Windows Millennium Edition (ME), or Windows 2000 Professional

• at least 40 megabytes of free disk space

• an infrared port on your desktop PC or laptop computer and/or the optional DLR-3P cable

• a compatible PC Personal Information Manager (PIM) application for use with Nokia PC Sync

Note: Nokia Content Copier (a component of Nokia PC Suite) supports a variety of Nokia phones, some of which make their 
connection to a PC via serial cable. For a list of compatible phones and connection methods, please see “Compatible phones” 
on page 5.

 • COMPATIBLE APPLICATIONS
Nokia PC Sync is compatible with the following Personal Information Manager (PIM) applications:

 • REQUIREMENTS FOR DIGITAL DATA AND FAX CALLS
Note: This feature is available only if your service provider’s network supports digital data calls. Please check with your 
service provider prior to sending or receiving digital data calls.

Before you can make digital data calls using your Nokia phone as a wireless modem:

• you must subscribe to digital data services with your service provider.

• your phone must be powered up, and digital service must be available. Digital data calls are not available when outside of a 
digital network.

• your phone must be connected to your PC or handheld device via infrared or the DLR-3P cable.

• your data or fax software must be running and must be configured to recognize your Nokia phone as the active modem 
(instructions to follow later in this document).

 • PRINTING THIS GUIDE
You may find it helpful to print this guide for future reference. 

No other applications should be running during the installation of PC Suite and during wireless modem setup. Therefore, reading 
this guide using Adobe Acrobat reader during installation is not recommended. Printing a copy of this guide provides you access 
to the instructions during the installation process.

Manufacturer Application name/version

Microsoft Schedule+ 7.0, 7.5
Outlook 97, 98, 2000, 2002

Outlook Express

IBM Lotus Notes 4.5, 4.6, 5.0
Lotus Organizer 97, GS, 5.0, 6.0
[ 1 ]
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 • ABBREVIATIONS
For the purposes of this user guide, the following abbreviations are used:

 • SAFETY NOTES
• Please make backup copies of all important data to protect against possible loss or alteration.

• When connecting to any other device, read its user guide for detailed safety instructions. Do not connect incompatible 
products. 

• To avoid any potential loss of data, you should not make or receive calls while synchronizing data between the phone and a PC.

• Do not point the IR beam at anyone’s eyes or allow it to interfere with other IR devices.

 • INFRARED COMMUNICATIONS
Infrared (IR) is one of the two available options for connecting your phone and PC. If you choose IR for your connection, please 
note that the preferable distance between two devices in an infrared connection is a range of three inches to three feet maximum. 
There must be no obstructions between the two devices and the IR ports of the two devices have to be pointing at each other.

Your Nokia phone is a Class 1 Laser Product.

Enable infrared communications
Windows Millennium Edition (ME) and Windows 2000 users do not need to enable infrared communications on their PC prior to 
using this feature. The infrared port is always active.

If you use Windows 95 or Windows 98, you can use the infrared control panel to activate or deactivate infrared communications. 
Before installing PC Suite, please enable IR communications on your PC.

For more information on enabling infrared communications on your phone, please refer to the infrared section in your phone’s user 
guide.

Interruptions to infrared communications
Windows provides visual and audible notification when it senses an 
interruption to infrared communications between your phone and PC. 
Windows allows you to re-establish infrared communications between 
the two devices so it can re-send the data that was being transferred 
when the interruption occurred.

TIME-OUT
If the infrared connection between your phone and PC has not been re-established within 15 seconds, a “time-out” occurs, meaning 
Windows no longer searches for your phone and terminates the infrared connection.

Abbreviation Description

PC Refers to both desktop and laptop computers

IR Infrared

PIM Personal Information Manager (PC-based software program)
[ 2 ]
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2 Install Nokia PC Suite 4.4
Nokia PC Suite 4.4 is a collection of powerful tools that you can use to manage your phone’s features and data. PC Suite consists 
of the following components:

• Nokia Content Copier allows you to copy data between two Nokia phones, to back up your phone’s data to your PC, and erase 
data from your phone. 

• Nokia Connection Manager allows you to monitor the serial connection between your phone and PC and switch to a different 
type of connection (cable vs. infrared) when copying data from one phone to another.

• Nokia PC Composer allows you to create new ringing tones for your phone.

• Nokia PC Sync allows you to synchronize contacts, calendar, and to-do list notes between your phone and PIM applications 
such as Microsoft Outlook and Lotus Organizer.

• Nokia PC Graphics allows you to create new caller group logos and picture messages or allows you to edit picture messages 
already in your phone.

• Nokia Phone Editor allows you to edit your phone book and settings from your PC.

 • IMPORTANT NOTE ABOUT IR FOR WINDOWS ME AND XP USERS
Your phone also functions as a wireless modem and is designed to be detected by Windows Plug and Play. During the PC Suite 
installation process, you are asked to choose how you want to connect your phone and PC - either via IR or the DLR-3P serial cable.

If you select IR, you are prompted to enable infrared communications on your phone, then align the infrared ports of the 2 devices.

Plug and Play detection
Because infrared is always active on your PC (including automatic software installation for Plug and Play devices), the Windows 
Add New Hardware Wizard detects your phone as a new hardware device during the PC Suite installation. This interferes with the 
PC Suite software installation process.

Before installing PC Suite
Nokia recommends that Windows Me and XP users who want to use IR as their serial connection for PC Suite perform the modem 
installation prior to installing PC Suite. Please see “Wireless modem setup for Nokia 6360 phone” on page 25 and perform this task 
prior to installing Nokia PC Suite. Once you have performed the modem installation, you may continue with the installation 
instructions below.

 • PC SUITE INSTALLATION INSTRUCTIONS
Please download the setup application to a location on your hard drive. If you downloaded the application in segments, please 
double-click the .exe file and follow the instructions to extract the installer application from the segments.

Important: If you use Windows 98 (First or Second Edition) and plan on using IR to connect to your PC, please enable IR 
communications on your PC now.

Once the software download is complete and/or the segments have been rejoined:

1 Double-click the installation file Nokia PC Suite 4.4.exe that you downloaded to your hard drive.

2 Click Next to begin the software installation process.

3 Please read the end-user license agreement, then click Yes to accept its terms.

4 Review the safety notes, then click Next.

5 Click Next to install all PC Suite components (or clear the check boxes of the components you do not want to install).

6 Select the language you wish to use with PC Suite, then click Next.

Note: If you have a PIM application installed on your PC (Outlook, Lotus Organizer, etc.) and you want to use it with Nokia 
PC Sync, it is recommended that you select the same language used by your PIM.
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Select your connection method
During the installation process, you are asked to select how you 
plan on making a connection to your PC (either infrared or the 
DLR-3P serial cable). 

You can only use one method at a time. However, you may want to 
select both options during installation in the event you want both 
connection options available at a later time. 

1 Select the type of connection you want, then click Next. 

2 Follow the instructions provided on either the Infrared 
connection or Cable connection screen, then click Next. 

3 Continue through the installation wizard, then click Finish to 
restart your PC.

Change language
The language chosen during installation for PC Suite applies to all of the PC Suite components and Help applications. If you need 
to change PC Suite to a different language, you must reinstall PC Suite.

 • REMOVE PC SUITE
If you need to remove PC Suite (including all components), please use Add/Remove Programs (located in Control Panel). Remember 
to close any PC Suite applications that are running before you begin.

TO REMOVE PC SUITE 4.4:
1 Click Start, point to Settings, then click Control Panel.

2 Double-click Add/Remove Programs.

3 Scroll through the list of installed applications, then click Nokia PC Suite 4.4.

4 Click the Add/Remove button.

5 Click Remove from the Nokia PC Suite Setup window, then click Next.

6 Follow the on-screen instructions until the setup wizard has completed removing the program.

7 Restart your computer to complete the removal process.
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3 Nokia Content Copier
Nokia Content Copier is a powerful application that allows you to perform 
the following tasks:

• Copy data from a compatible phone to your 6360 (or between 2 Nokia 
6360 phones).

• Back up your phone’s data to your PC and then restore the data back 
to your phone.

• Erase data from your phone.

 • COMPATIBLE PHONES
One of the most powerful features of this application is its support of other compatible phones. This capability is especially useful 
if you are upgrading to a new handset and want to transfer data from your old phone to your new one. You can also use this 
application to transfer information between other 6360 phones in your family.

The following table shows a list of phones compatible with Nokia Content Copier (other than 6360), as well as the method of 
connection to the PC:

Important: Content Copier does not support copying data to any of the phones listed above. Data can only be read from 
these phones, then copied to 6360.

Note: Nokia Content Copier does not support certain 5100 and 6100 series phones. For more information on specific models 
of incompatible phones, please see “Other phones” on page 7.

 • CONTENT COPIER BASICS
Nokia Content Copier uses a wizard-style interface to help you 
perform the tasks listed above. If you are copying data from one 
of the compatible phones above using a cable connection, please 
make sure the phone is connected to your PC via cable before 
you begin.

Launch Content Copier from the Start Menu (Start - Programs - 
Nokia PC Suite 4 - Content Copier), then select the task you 
would like to perform. Follow the on-screen instructions to 
complete the task you want to perform.

The following pages contain basic information and tips on using 
Nokia Content Copier.

Important: Windows Millennium Edition (ME) users should have already performed the wireless modem installation before 
installing PC Suite. If the Add New Hardware Wizard launches when you establish an infrared connection between phone 
and PC, please click the wizard’s Cancel button. Close Content Copier, then proceed to “Wireless modem setup for Nokia 6360 
phone” on page 25 and follow the instructions. You can return to Content Copier once the modem setup has been completed.

Nokia model: Method of connection:

3320/3360 IR (infrared)

5190/6190 DAU-9P serial cable

6340, 6360 DLR-3P serial cable and IR (infrared)

7160 DLR-3P serial cable and IR (infrared)

7190 DLR-3P serial cable and IR (infrared)

8290, 8890 IR (infrared)

8390 IR (infrared)
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Copy information from the source phone
When you select Copy data from a phone to a PC, Content Copier 
transfers all compatible data types (phone book, calendar, to-do, caller 
groups, etc.) from the phone containing the data you want to back up or 
transfer. This phone is called the “source phone” and can be one of the 
phones listed on the previous page, or another Nokia 6360 phone.

• If you are copying your phone’s data and want to save it on your PC, 
Nokia Content Copier guides you through the process of saving the 
information to your PC’s hard drive.

• If you are copying data from a different source to your Nokia 6360, 
the data must first be saved to your PC. Once you have connected 
your 6360 (“target” phone) via IR or cable, follow the instructions 
found below: “Copy information to the target phone”.

Save the source phone data
Once the source phone’s data has been read, Content Copier allows you 
to save the information to your PC’s hard drive. Click the Save Data 
button, then navigate to the location on your hard drive where you want 
the information stored.

Nokia Content Copier automatically names the files for you, based on the 
type of data that is read from the source phone.

Copy information to the target phone
Before you can copy information to the target phone, you need to load 
the information into the PC’s memory. You should have already saved the 
source phone’s data to your PC via the Copy data from a phone to a PC 
option. 

1 Launch Content Copier, then click Next.

2 Click Next, then click Copy data from a PC to a phone. 

3 Click the Select source Folder button. Locate the directory 
containing the information you want to use. 

4 Click Next to begin copying data from your PC to your phone.

Once the source phone’s information has been loaded from your PC’s hard drive, you are asked to determine the types of 
information you want copied into your phone. The compatible data types are displayed along with the ability to select the types 
of data you wish to transfer.

Use the check boxes next to the data types to select or deselect the information you want to copy to your phone.

Nokia Connection Manager
You may need to use Nokia Connection Manager to select the type of connection you want Content 
Copier to use during various stages of the process. For example, if you copy data from one of the phones 
listed on the previous page and the source phone requires a serial cable, click Content Copier’s 
Connection button to launch Connection Manager. Then select the correct cable option for the source 
phone.

To switch connection type while using Content Copier:

1 Establish the appropriate connection between your phone and PC (via 
IR, DLR-3P, or DAU9-9P), then click the Connection button.

2 Click the desired connection type, then click Select.

3 Allow Nokia Connection Manager to detect your phone.

4 Click OK to return to Nokia Content Copier.

If your phone is not detected right away, switch to one of the other 
connection types, then back to the desired connection type. This forces 
Connection Manager to redetect your phone.
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Note: If you are copying data from one phone to another and the source phone uses an infrared connection, stop the infrared 
connection between source phone and PC. Allow the Windows warning message regarding interrupted infrared 
communications to completely time-out before aligning the target phone with your PC’s infrared port. By doing so, you allow 
Connection Manager to detect your phone more quickly.

Nokia Content Copier log
When you have successfully completed one of the Nokia Content Copier tasks, the Finish screen is displayed along with a log of 
the tasks that were just performed. At the Finish screen, you have the following options:

• Click Save to save the log (.LOG) file to your PC’s hard drive.

• Click New Action to return to the beginning of the Nokia Content Copier wizard.

• Click Finish to exit Nokia Content Copier. 

 •  OTHER PHONES
Due to software and hardware differences between generations of phone technology, the following phones are not compatible with 
Content Copier: 

Protocol Nokia model number

TDMA 5120, 5125, 5160, 5165

6120/6120i, 6160/6160i/6160m

6161/6161i, 6162/6162i/6162m, 8260

CDMA 3280, 3285

5170/5170i, 5180/5180i, 5185

6180/6180i, 6185/6185i

GSM1900 3390, 3395
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Nokia PC Composer allows you to create new ringing tones for your Nokia phone. Once you create a new ringing tone, you can 
transfer it to your phone (via IR or DLR-3P cable).

PC Composer also allows you to open Standard MIDI files (type I), edit them, and convert them to ringing tones. You can save your 
ringing tones as either .mid (MIDI) or .ott (ringing tone) file formats on your PC’s hard drive. Once saved on your hard drive, you 
can also share your new ringing tones via e-mail with friend or family who also use a compatible version of PC Suite.

PC hardware setup
PC Composer “plays” the notes as they are written to the music staff. You can also play back the entire composition. Before you 
begin writing, you must select your PC sound card’s MIDI playback device.

1 Click Start, point to Programs, point to Nokia PC Suite, then click Nokia PC Composer. 

2 Click Tools, point to Player Device, then click the option for your sound card’s internal MIDI playback device.

Once your MIDI playback device is set, you can hear each note as it is added to the staff or listen to the entire ringing tone (when 
you click the Play button).

 • TOUR OF PC COMPOSER
The illustration below introduces you to PC Composer’s tools and commands:

Connection status

Switch view (displays event tracker window)

Note values Rest values

File management
(new, open, save)

Note counter

Selection tool

Play ring tone

Stops playback

Record mode 
(displays 
recording 
keyboard)

Adds dot or double 
dot to selected note

Raises a note’s
pitch 1/2 step

Insert point

Status bar 
displays help 
texts and 
toolbar tips

Triplet
(use to create 
triplets with 
selected notes)

Transfer tone to phoneEditing tools
(cut, copy, paste)
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You can launch PC Composer without having an infrared connection between the phone and your PC. The connection status 
indicator displays the status of the connection between your phone and PC.

 • COMPOSE A NEW RINGING TONE
Your new ringing tone can consist of up to approximately 70 notes and rests. The 
phone discards any notes or rests beyond 70. Use the note counter to the right of 
the Status Bar to monitor the length of your new ringing tone.

Create a new ringing tone
1 Launch Nokia PC Composer (click Start, point to Programs, point to Nokia PC 

Suite, then click Nokia PC Composer). 

2 Click the appropriate note (or rest) button.

3 Using the insert point, click the desired line or space on the staff (result: the 
note is placed on the staff, and is played by your PC’s sound card).

4 Continue entering the desired notes and/or rests until you have completed your new ringing tone.

5 Click the Play button  to play the ringing tone from the beginning.

Enter notes using the recording keyboard
In addition to placing the notes on the staff using the mouse, you can also enter 
the pitches from your computer keyboard. The recording keyboard is displayed and 
identifies the computer keyboard equivalents to notes on a piano or MIDI 
keyboard.

1 Click the Record button  to display the recording keyboard.

2 Click the desired note value button on the toolbar.

3 Press the key on your computer keyboard associated with the desired note.

Tip: If you want a longer or shorter note, select the desired note value from the toolbar, then enter the note’s pitch from 
your keyboard. Note values cannot be selected from your computer keyboard.

Edit a ringing tone
You can edit the pitch or duration of the notes already entered on the music staff.

CHANGE THE PITCH OF A NOTE
1 Click the Selection tool button  on the toolbar.

2 Move the cursor over the note you wish to change (result: the arrow cursor changes 
to a hand)

3 Drag the note up or down on the staff to the correct location.

CHANGE THE DURATION OF A NOTE OR REST
1 Click the desired note button (or rest button) on the toolbar.

2 Move the cursor over the note or rest you wish to change (result: insert point appears)

3 Click the note or rest to replace it with the new note value.

Delete notes and rests
You can delete a wrong note/rest or group of wrong notes/rests at any time.

DELETE A SINGLE NOTE/REST
1 Click the Selection tool button on the toolbar.

2 Click the note or rest you want to delete, then press your keyboard’s Delete (DEL) key.

Insert point
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DELETE MULTIPLE NOTES/RESTS
1 Click the Selection tool button on the toolbar.

2 Draw a bounding outline (marquee) with the mouse around the group of notes or 
rests you want to delete (result: the group of notes are highlighted in blue).

3 Press your keyboard’s Delete (DEL) key.

 • OTHER PC COMPOSER VIEWS
In addition to using the standard music staff to compose new ringing tones, the following options are available:

• Tracker - displays notes as events on a time line as well as other MIDI and tempo data

• General - used to set Song Title, overall tempo, and adjust overall pitch up or down

Click the Switch view button  to cycle through the various view options.To view the General information pane, click Tools, 
then click General.

 • SAVE YOUR NEW RINGING TONE
When you are ready to save your new ringing tone, click the Save button on the toolbar. Use the Save as dialog box to set file name 
and location to save the new file. Default file type for your new ringing tone is .mid (MIDI). However, you need to save your work 
as ringing tone format (.ott) before sending your new ringing tone to the phone. Use the Save as type drop down box to select the 
desired file type.

Note: You can create and save as many new ringing tones as you have space on your hard drive. However, your phone can 
only hold up to five new ringing tones at any given time.

 • TRANSFER RINGING TONE TO YOUR PHONE
Once you have created a new ringing tone and have saved it to your PC, you can transfer the tone to your phone. When your phone 
receives the new ringing tone, it displays the message New ringing tone received. Press the Options key and scroll to the following 
options:

• Playback - plays the new ringing tone

• Save tone- saves the ringing tone to your phone

• Discard - discards the new tone and returns you to the Start screen.

Transfer via infrared or cable
Before transferring the ringing tone to your phone, make sure you have established a connection between your phone and PC. 
Check the status indicator in the lower right corner of the PC Composer window to verify the status of your connection.

Important: Make sure to display the General pane and enter a name for your new ringing tone. If you fail to do so, your new 
ringing tone may not be named properly.

Use to create text 
note to be saved as a 
part of the .ott or 
MIDI file

Use to set name of 
ringing tone as it 
appears in phone

Set overall tempo 
of ringing tone

Raise or lower 
overall pitch of 
ringing tone

Use to add notes, 
adjust note pitch or 
value, and modify 
tempo
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To transfer your ringing tone, click the Update to Phone button on the toolbar  (or select Update to Phone from the Tools 
menu).

 • CREATE RINGING TONES FROM MIDI FILES
Nokia PC Composer allows you to open Standard MIDI files, then convert the data to ringing tone format. Now you can carry your 
favorite PC MIDI file as a ringing tone in your phone!

About Standard MIDI files
Standard MIDI files of popular music frequently consist of multiple instruments (bass, drums, organ, etc.). Typically, there is also a 
track dedicated to the song’s melody. There are two types of Standard MIDI files:

• Type 0 files - 1 track of MIDI data containing all the various instruments; each instrument assigned to different MIDI “channel.”

• Type 1 files - each instrument has its own dedicated track and MIDI channel. Track/instrument names are embedded in the file 
as text information.

PC Composer’s interface interprets the multiple track information and allows you to choose the correct track or instrument.

Important: PC Suite supports Type 1 MIDI files only. PC Suite cannot display the necessary note and instrument data when 
opening Type 0 MIDI files. If you try to open a Type 0 file, no data is displayed.

Before you begin
If the MIDI sequence you want to use contains too many notes, the following error message is displayed when trying to open the 
file:

Nokia PC Composer processes MIDI notes in octave 5 and 6 of the MIDI keyboard. If your MIDI sequence contains notes outside 
this range, the following error message is displayed when opening the file: 

OPEN A STANDARD MIDI FILE
 To open a MIDI file:

1 Click the Open button  (or select Open from the File menu).

2 Locate the MIDI file you want to use as a ringing tone, then click Open.

3 Use the Track list box’s drop-down arrow and locate the desired track.

4 Click the Convert track to tone button to convert MIDI information to ringing tone format.

Track list
box
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Edit and save
You may need to edit the converted MIDI information (adjust note lengths, remove extra rests, etc.) so that the ringing tone plays 
correctly. For more information on editing a ringing tone, please refer to “Edit a ringing tone” on page 9. 

When you have completed editing the ringing tone, you can save your work in ringing tone (.ott) format, then send the new tone 
to your phone. For more information on saving, please refer to “Save your new ringing tone” on page 10. For more information on 
sending a ringing tone to your phone, please refer to “Transfer via infrared or cable” on page 10.

 • WORK WITH RTTTL RINGING TONE FILES
Ringing Tones Text Transfer Language (RTTTL) files are text files that contain various types of information that make up a ringing 
tone. When your phone receives a ringing tone over the air, your phone is actually receiving the information in RTTTL format. The 
RTTTL file includes song title, scale and tempo indications, and the actual note information. 

An RTTTL formatted ringing tone may appear as follows:

Use RTTTL data from the Internet
The Internet has become a popular source for sharing ringing tones in RTTTL format. If you find a ringing tone Web site displaying 
the RTTTL data, you can create your own RTTTL files by pasting the data into a text editor program (for example: Notepad), then 
save the file using the .txt file extension. 

PC Composer can open (and save) ringing tones in RTTTL format. Songs you compose in PC Composer can be saved as RTTTL files, 
then shared with family and friends via e-mail (for example). 

Open an RTTTL file
1 Click the Open button  (or select Open from the File menu).

2 Click the File of type drop down arrow, then select RTTTL files (*.txt) from the list of available file types.

3 Locate the RTTTL file on your hard drive or other removable disk drive, then double-click the file name to open.

4 Click the Convert track to tone button and convert file to ringing tone format.

You can now send the ringing tone to your phone, edit the ringing tone (as needed) and/or save the ringing tone as .ott (ringing 
tone) format on your hard drive.

babbino:d=4,o=5,b=140:g#,g#,g#,2c6,g,2f,8p,2d#,g#,a#,c6,2g#,g#6,2d#6

song title scale and tempo data note data
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5 Nokia PC Sync
Nokia PC Suite allows you to synchronize the contact and calendar information in your PC’s Personal Information Manager (PIM) 
software and your Nokia mobile phone. You can use Nokia PC Sync to keep information up-to-date in both locations.

PC Sync supports a variety of PIM applications, including Microsoft Outlook, Outlook Express (via Windows Address Book), and 
Lotus Organizer. PC Sync also offers a wide variety of synchronization options so that you can personalize the way you want your 
information managed.

Warning:To avoid any potential loss of data, you should not make or receive calls while synchronizing data 
between the phone and your PC. Nokia PC Sync cannot be used while a data call is in progress. Likewise, you 
cannot initiate a data call while synchronizing data with PC Sync.

Important: Remember to make backup copies of all important data to protect against possible loss or alteration.

 • CONFIGURE PC SYNC
The first time you run Nokia PC Sync, you must configure PC Sync to 
work with your PIM application. Once you have customized PC Sync, you 
can proceed with synchronizing your PIM data with your phone.

1 Establish a connection between your phone and PC (IR or cable).

2 Launch Nokia PC Sync (click Start, point to Programs, point to 
Nokia PC Suite 4, then click Nokia PC Sync). 

3 Select your PIM application from the drop-down list, then click OK.

4 Click the More button to view a summary of current/default 
settings.

Set General synchronization properties
1 Click the General tab, then select the information you want to 

synchronize.

2 Click the desired option for automatic synchronization (example: 
Every connection).

3 Click the Advanced button to specify additional options, including 
resolving synchronization conflicts (see below)

SYNCHRONIZATION CONFLICTS
A synchronization conflict occurs when you change or edit a contact, 
calendar or to-do list note in both your phone and PIM between 
synchronization sessions. By default, PC Sync resolves the conflict by 
treating your phone as the correct information source.

To change conflict resolution properties, click the option associated 
with your PIM application.

Set Calendar and Contacts properties
Your PIM application’s storage capabilities are much more extensive 
than those of your phone. Use the Calendar and Contacts tabs to define 
the kinds and amount of information synchronized.

For more information about the capacity of your phone’s phone book 
and reminder list, please refer to the technical specifications section of 
your phone’s user guide.

1 Click the Calendar/To-do tab.

2 Use the drop-down lists to define the range of time PC Sync uses 
during synchronization.
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3 Click the Contacts tab.

4 Select the details you want synchronized with your phone.

CONTACT DELETIONS
By default, contacts deleted from your phone are not deleted from your 
PIM when you synchronize. If you accidentally delete a contact from 
your phone, you can restore it by synchronizing again.

Deselecting the Ignore contact deletions option instructs PC Sync to 
permanently delete the corresponding contact in your PIM. Choose this 
option only when you are certain you want PC Sync to delete the PIM 
contact (and all details) associated with the deleted phone book entry.

Warning: This action cannot be undone!

Set PIM properties
The last properties tab is labeled with the name of your PIM application. Use this properties tab to modify how PC Sync 
communicates with your PIM’s resources. For example: If your PC is configured for multiple users., the default location of your 
PIM’s databases may be stored in a user profile directory (vs. the default location for single-user PCs). PC Sync returns an error 
message if it cannot find your PIM’s data.

Use the PIM properties tab to select the correct location of your PIM’s databases containing current contacts, calendar, and to-do 
list information.

Synchronizing for the first time
Once you have customized PC Sync for your uses, you are ready to 
synchronize your phone and PIM.

1 Click the Summary tab

2 Click the Synchronize Now button.

3 Observe the synchronization status indicator.

4 Click the OK button when synchronization is complete.

Important: Please refer to the PC Suite Troubleshooting document in the event synchronization is not successful or if PC 
Suite notifies you of errors. A link to this document can be found in the Nokia PC Suite 4 Program Group.

 • UNDERSTAND THE BASICS OF SYNCHRONIZATION
Nokia PC Sync remains running in the background after you synchronize for the first time. PC Sync places an icon in the Task Bar 
tray, indicating that the application is running. The colors of the icon change, depending on the status of the infrared connection 
between your phone and PC. Please refer to the examples below:

Exit PC Sync
Once setup and first synchronization is complete, you can either leave the program running in the background, or you can exit PC 
Sync. To exit PC Sync:

• right-click the PC Sync tray icon , then click Exit.

Start PC Sync
You have two options for launching Nokia PC Sync:

• on an as-needed basis from the Start menu

• automatically upon startup

Blue and green
indicates a connection

present between phone
and PC.

Yellow and gray 
indicate no connection 
present between phone 
and PC.
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TO ENABLE PC SYNC ON STARTUP
1 Establish an infrared link between your phone and PC.

2 Launch PC Sync from the Start menu.

3 Right-click the PC Sync tray icon, then click Enable on startup

View other PC Sync options
There are several other options available from the PC Sync options menu 
(from the tray icon). With the phone connected to your PC, right-click on the 
tray icon, then click any of the following options:

• About - to view information about the PC Sync program

• Connection - to check the status of the PC/phone connection

• Properties - to modify current PC Sync settings (change frequency of synchronization, types of data synchronized, etc.)

• Synchronize - to initiate synchronization of data

• View Last Report - to view information about the last synchronization attempt

• Help - to launch the on-line Help files

• Exit - closes the PC Sync program

To disable the auto start features, right-click on the PC Sync icon, then click Enable On Startup again.

 • INITIATE SYNCHRONIZATION 
PC Sync initiates synchronization between your phone and PC when you start the program from the Start menu. To synchronize 
your data again while the program is still running, right-click the PC Sync tray icon, then click Synchronize.

 • USE THE NEW SYNCHRONIZATION COMMAND
If at some point you change PIM applications or upgrade to a newer version of your current PIM, you must configure PC Sync to 
work with the new application. Select New Synchronization from the Nokia PC Suite program group, then follow the instructions 
on page 13.

Important: Do not use New Synchronization to launch PC Sync and initiate synchronization between your phone and PC. 

 • CREATING A CUSTOM CONTACT LIST
Users who have more than 500 names and numbers in their PIM should create 
a custom contact list or subset of their master contact list. Depending on the 
PIM application you use, you may need to create a new contact database file 
or create a new folder for storing the custom contact list.

Outlook users
Outlook users can create folders and sub-folders in their Outlook database 
files. To create a custom contact list, first create a new folder to store 
contacts. Then copy the desired contact information from your main contacts 
folder to the new folder. PC Sync allows you to synchronize your phone with 
the Outlook contacts folder of your choosing.
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CREATE A NEW FOLDER FOR PHONE CONTACTS
To create a new sub-folder for a custom contact list:

1 Click File, point to Folder, then click New Folder.

2 Type the name of your new folder (example: Phone list).

3 Click the Folder contains drop-down arrow, then click Contact Items.

4 Select a location for your new folder (example: click Contacts to make 
Phone list a sub-folder of your main Contacts folder).

5 Click OK to confirm your selection.

COPY CONTACTS TO CUSTOM PHONE LIST
1 Click the Contacts button on your Outlook bar .

2 Select the contacts you want to appear in your custom list (Hold the CTRL key, then click to select multiple contacts that are 
not adjacent to each other). 

3 Click Edit, then click Copy (or press CTRL + C).

4 Select your custom folder from the Folder List (example: Phone list), or press CTRL + Y to display Go to Folder dialog box.

5 Click Edit, then click Paste (or press CTRL + V) to paste copies of the selected contacts into the new folder.

Important: If you decide to drag-and-drop contacts between your main Contacts folder and the new custom folder, make 
sure to hold the CTRL key while dragging, then release the mouse button first. Failure to use the CTRL key during drag-and-
drop moves all selected contacts to the new folder.

UPDATE PC SYNC’S OUTLOOK SETTINGS
To update PC Sync’s settings to synchronize with your custom list:

1 Establish an infrared connection between your phone and PC.

2 Launch Nokia PC Sync from your PC’s Start menu.

If you have PC Sync enabled on startup, right-click the PC Sync tray icon, then click Properties.

3 Click the Microsoft Outlook tab.

4 Click the Contacts browse button , then select your custom folder. 
Click OK to confirm your selection.

5 Click the Summary tab, then click Synchronize Now to synchronize your 
phone and custom phone list.

Other PIM applications
Other PIM applications (such as Lotus Organizer) require that you create a completely new database file for your custom contacts 
list. Once you create a new database file, copy the desired contact information from your main contacts file to the new contacts 
file. PC Sync allows you to synchronize your phone with the contacts file of your choosing. 

CREATE A NEW DATABASE FILE (EXAMPLE: LOTUS ORGANIZER)
1 With Lotus Organizer running, click File, then click New.

2 Click File, then click Save As.

3 Enter a name for your custom phone list (example: Phone list).

COPY CONTACTS TO CUSTOM PHONE LIST
1 From File Manager, open your default Organizer database 

(c:\lotus\work\organize\<filename>)

2 Click the Contacts tab, then click the desired alphabet tab.

3 Select the desired contacts for your custom list.

Tip: Hold the CTRL key to select multiple contacts that are not 
adjacent to each other. 

4 Continue by clicking subsequent alphabet tabs and selecting the 
desired contacts.

5 Click the Copy button (or press CTRL + C).

Selected 
records
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6 Use the Windows Task Bar to switch back to your new contacts list, then click the Contacts tab.

7 Click the Paste button (or press CTRL + V) to paste copies of the selected contacts into the new list.

UPDATE PC SYNC’S LOTUS ORGANIZER SETTINGS
1 Establish an infrared connection between your phone and PC.

2 Launch Nokia PC Sync from your PC’s Start menu.

If you have PC Sync enabled on startup, right-click the PC Sync tray icon, then click Properties.

3 Click the Lotus Organizer tab.

4 Click the Contacts browse button , then select your custom 
folder. Click OK to confirm your selection.

5 Click the Summary tab, then click Synchronize Now to synchronize 
your phone and custom phone list.
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6 Nokia PC Graphics
Nokia PC Graphics is a program that allows you to create and edit picture messages, as well as graphics that can be used for picture 
messaging. You can also create and edit new caller group logos. 

Once you create or modify a graphic, you can transfer it to your phone (IR or DLR-3P cable). You can also save your work to disk 
for use at another time, or to send via e-mail to friends and family who also use a compatible version of PC Suite. 

 • TOUR OF PC GRAPHICS
The illustration below introduces you to PC Graphic’s tools and commands:

 • CREATE A NEW GRAPHIC
Nokia PC Graphics provides you with easy to use drawing tools so you can create your own unique caller group logos or picture 
messages. Before you begin drawing, select the type of graphic you want to create.

Important: You do not need to establish a connection (IR or cable) between your phone and PC to create a new graphic. You 
only need to establish a connection when preparing to send the new logo or picture message to your phone.

Choose a picture type
1 Launch PC Graphics (click Start, point to Programs, point to Nokia PC Suite 4, then click PC Graphics).

2 Click Tools, point to Picture type, then click one of the following options:

• Group logo - used to create new caller group logos

• Picture message - used to create picture messages

If you select Picture message, use the Size option from the Tools menu to select the size of the picture used in the picture message.

Tip: Selecting the larger picture size reduces the number of characters that accompanies the picture message (maximum 
of 121 characters).

Draw a new picture
The type of picture you select determines the size and overall dimensions of the drawing area. The drawing area 
is divided into blocks that can be filled in to create the new picture. 

Your cursor becomes a pencil that you can use to fill in each block. Use the left mouse button to fill each block 
with black. If you make a mistake, use the right mouse button to erase (or fill the block with white).

Connection status

Read logo or picture 
message from phone

Displays graphic type and size

Enter text for picture 
message here

Preview of picture 
message or caller 
group logo

Drawing area

Status bar 
displays help 
texts and 
toolbar tips

Transfer logo or picture 
message to phone

Drawing tool

Click to change 
graphic type (caller 
group logo or 
picture message)

File management
(new, save, open)
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Save a picture
PC Graphics allows you to save your work as a file on your PC’s hard drive. Saving your logos and picture messages to your hard 
drive creates a backup copy of your work. You can also save your work, then open the file at a later time for further edits or to send 
the picture message or logo to your phone.

Tip: PC Graphics automatically selects the correct file type based on the picture type you selected. File types supported: 
Picture message files (*.gms), OTA Bitmap Files (*.otb), and Bitmap files (*.bmp)

1 Click the Save button on the toolbar (or click Save on the File menu). 

2 Select a location to save your work, then enter a name for your picture.

3 Click Save to complete the task.

 • TRANSFER A GRAPHIC TO YOUR PHONE
Once you create a new caller group logo or picture message on your PC, you can transfer the information to your phone using 
either IR or cable connection. Make sure you establish a connection between your PC and phone before you begin.

Transfer a group logo to your phone
1 Click the Update to phone button  on the toolbar (or select the Update 

to phone command from the Tools menu).

2 Click the name of the caller group from the list of logos (example: Other). 
The logo you created replaces the existing logo for the selected caller group.

3 On your phone, press Names, scroll to Caller groups, then press Select.

4 Scroll to the caller group you selected in step 2 above, then press Select.

5 Scroll to Group logo, then press Select.

6 Scroll to View, then press Select to confirm the transfer of the logo to your phone.

Transfer a picture message to your phone
1 Click the Update to phone button  on the toolbar (or select the Update 

to phone command from the Tools menu).

2 Click one of the existing picture message locations from the list
(or select First empty location). 

The picture message you created in PC Graphics replaces the existing message 
in the location you selected. If you selected First empty locaiton: 

3 Press Menu 01-6 (Messages > Archive), then press Open. The new picture 
message appears in your phone’s Archive folder for sending at a later time. 

Note: For more information on saving pictures in your phone, please refer to your phone’s user guide.

 • WORK WITH AN EXISTING GRAPHIC
PC Graphics allows you to edit any of the picture messages already in your phone. Or you can open and modify logos and picture 
messages that you’ve saved on your PC. Make sure you establish a connection between your PC and phone before you begin.

Edit a picture message stored in your phone
With the Nokia PC Graphics application running:

1 Click Tools, point to Picture type, then click Picture message.

2 Click OK (as needed) to confirm any change in picture size required by 
Nokia PC Graphics.

3 Click the Read from phone button  (or select the Read from phone 
command from the Tools menu).

4 Select the picture message or picture you want to edit from the list, then 
click Read.
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Once the picture message has been loaded into your PC from your phone, use the pencil tool to edit the image. Click the Update 
to phone button on the toolbar to transfer the picture back to your phone.

Open a graphic you created
You may want to save picture messages or caller group logos on your PC so you can re-use them at a later time. 

Click the Open button  on the toolbar (or select Open from the File menu) to locate a graphic you’ve saved. You can then edit 
the graphic (as necessary), transfer the graphic to your phone, or send it to another user via SMS.

 • OPEN OTHER BITMAP FILES
Nokia PC Graphics has the ability to open and convert 
Windows RGB-coded bitmap images for use with picture 
messaging and caller group logos. 

Nokia PC Editor provides tools to select or “capture” the 
portion of the image you want to use, as well as for 
adjusting the image and converting it to black and white 
for use in your phone.

NON-SUPPORTED FILE FORMATS
If the image you want to use is not Windows bitmap 
format (JPEG, GIF, etc.), you need to use another graphics 
application and convert the image to bitmap format.

Capture an image
Because of the size and dimension requirements of picture messages and caller group logos, you may only be able to use a portion 
of your image. Using the cursor, you can outline or “capture” that portion of the image you want to use.

PC Graphics captures your image at the correct height and width, based on your selection of Group logo or Picture message from 
the Tools menu.

With the Nokia PC Graphics application running:

1 Click Tools, point to Picture type, then select the type of graphic you want to create (Group logo or Picture message).

2 Click OK (as needed) to confirm any change in picture size required by PC Graphics.

3 Click the Open button  on the toolbar (or select the Open command from 
the File menu).

4 Click the File of type drop-down arrow at the bottom of the Open dialog box, 
then click Bitmap Files (*.bmp).

5 Locate and select the image you want to use, then click Open.

6 Move the mouse pointer over the drawing area until the pointer changes to a cross-hair.

7 Click and hold the left mouse button, then drag your mouse to draw a rectangle around the area you want to capture.

Tip: Once you define the capture area, you can still adjust the height and width using standard Windows resizing 
techniques. Move the cursor over the border of the capture area until the cursor shape changes, then drag to resize.

Adjust and edit image
A half-tone (black and white) preview of your selection appears in the lower right corner of the PC 
Graphics window. Use the slider to adjust the image for clarity and quality, as well as how PC Graphics 
converts the color information to black and white.

Once you’re satisfied with the quality of the captured image, click the Edit button. You can now make 
further edits to the image, or transfer the graphic to your phone.

Capture area

Halftone
adjustment

Edit button
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7 Nokia Phone Editor
Nokia Phone Editor is a program that allows you to edit and manage various functions of your phone from the keyboard of your 
PC. Phone Editor consists of the following components:

• Contacts - used to manage phone book entries. Also used to store contact information on your PC

• Profiles - used to edit profile and caller group settings from your PC

• Settings - used to view and modify various system and message settings. Also used to store configure your personal business 
card information

 • BEFORE YOU BEGIN
Make sure you establish a connection between your phone and PC before using Phone Editor. If your phone is not connected to 
your PC, you cannot edit and manage your phone’s information and settings. 

Important: Phone Editor cannot be used during active digital data or fax calls (and vice versa). Do not try to use these two 
features simultaneously.

 • PHONE MEMORY AND PC STORAGE LOCATIONS
Phone Editor uses your phone’s memory and your PC (RAM memory and hard drive storage) to store your phone’s data and settings:

Each time you launch Phone Editor, phone numbers, text messages and various phone settings are read into Phone Editor’s memory. 
When you terminate the PC connection or exit the program, your phone’s information is stored on your PC. The next time you use 
Phone Editor, the information stored on your PC is updated.

 • CHOOSE THE RIGHT APPLICATION FOR MANAGING CONTACTS
If you don’t already use a PIM application like Microsoft Outlook or Lotus Organizer, Nokia Phone Editor’s Contacts application is 
the perfect choice for editing and managing your contacts. Phone Editor creates a direct connection to you phone’s memory and 
allows you to add or modify your phone book quickly and easily.

Nokia Phone Editor limitations
Nokia Phone Editor can only manage contacts with one number per name. However, your phone’s memory is capable of storing 
multiple phone numbers and text fields (e-mail addresses, Web addresses, etc.) per entry. 

You cannot use Phone Editor to create or manage phone book entries with multiple names per number. Nor can you create or add 
text fields to any contacts you create in Phone Editor.

Note: When more than one number per name exists, Phone Editor displays the Mobile or General number you stored. For 
more information on number types and assigning or modifying number types, please see your phone’s user guide.

Use Nokia PC Sync
If you have multiple numbers and/or text fields per phone book entry you can 
still manage your phone book from your PC. This can be done easily by using a 
PIM application, along with Nokia PC Sync. For more information about Nokia 
PC Suite, please see page 13.

1 Launch your PIM application (example: Microsoft Outlook).

2 Locate the contact in your PIM that corresponds with the phone book entry 
you wish to edit (or create a new contact in your PIM).

3 Add or modify the contact information as necessary, then save your work.

4 Launch Nokia PC Sync and synchronize your PIM and phone.
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 • TOUR NOKIA PHONE EDITOR AND CONTACTS WINDOW

 • MANAGE CONTACTS USING PHONE EDITOR
Once you launch Nokia Phone Editor, click the Phone folder  in the contacts 
directory. A list of all phone book entries is displayed in the pane to the right of the 
contacts directory.

Many of the Phone Editor commands are available from the program’s shortcut menu. 
Select a phone book entry to edit, then right-click to display a list of the menu 
options available from the shortcut menu. Select the command you wish to perform 
from the list.

You can also find the same commands in the program’s Contact and Edit menus, or 
you can use the available toolbar buttons.

Add a new contact
1 Click the New Contact button  on the toolbar (or select New Contact from the shortcut menu).

2 Enter the name of the new contact, then press TAB.

3 Enter the phone number, then press ENTER to save your work.

EDIT CONTACT INFORMATION
1 Select the contact to edit from the list, then click the contact’s name (or number) in the contact card viewer.

2 Make the necessary changes, then press ENTER to save your changes.

Delete a contact
• Click the contact you want to delete from the list, then click the Delete button  on the toolbar. -OR-

• Right-click the contact you want to delete, then click Delete on the shortcut menu.

Editing tools (cut, 
copy, paste, delete)

Status bar displays
help texts and toolbar

tips

Memory status

Connection status

PC Editor
navigation bar

New contact

Contact card viewer

Contacts directory
(list of folders or
locations where

contacts are stored)

List of phone book 
entries for the 
selected folder.
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Copy and move contacts
Your PC’s hard drive offers you virtually unlimited storage space for names and numbers. You can copy phone book entries to the 
Phone Editor’s PC folder  to back up your data. Or you can move entries to the PC folder, making more memory available for 
other entries.

To copy or move contacts:

1 Click the folder containing the contacts you want to copy or move (example: Phone ).

2 Click the contact you wish to copy or move (or hold CTRL, then click to select multiple contacts).

3 Click the Copy button  to copy (or click the Cut button  to move).

4 Click the folder where you want the contacts stored (example: PC folder ).

Add a contact to a caller group
You can use Phone Editor to assign phone book entries to one of the available caller groups. If you are unfamiliar with the caller 
group feature, please see your phone’s user guide.

1 Right-click the contact you wish to assign to a caller group, then click Caller Group.

2 Click the drop-down arrow, then click the desired caller group.

3 Click OK to change the caller group assignment.

 • EDIT PROFILES AND CALLER GROUPS
You can use Nokia Phone Editor’s Profiles application to view your 
profiles and caller groups settings at a glance. You can edit profile and 
caller group settings quickly and easily from your PC’s keyboard.

Edit a profile 
1 Click the Profiles button on the Phone Editor’s navigation bar.

2 Click the name of the profile you want to edit from the list.

3 Use the drop-down arrows to modify the various profile settings.

4 Click Apply to apply the changes you make to your phone’s 
memory.

If you change the Alert for settings to one of the caller groups listed, 
your phone uses the profile you’re editing to notify you of callers 
assigned to that caller group.

RENAME THE SELECTED PROFILE
1 Click Edit, then click Rename.

2 Type the new name, then press ENTER to save your changes.

Edit caller groups
1 Click the Caller group tab (or click the Caller Groups folder).

2 Click the name of the caller group you want to edit from the list.

3 Use the drop-down arrow to select a new ringing tone for the 
selected caller group.

ADD/CHANGE GROUP GRAPHIC
1 Click the Location button, then navigate to the location of the 

graphic you want to use.

2 Select the caller group logo file, then click Open.

3 Click Apply to send the updated settings to the phone.

RENAME THE SELECTED CALLER GROUP
1 Click Edit, then click Rename.

2 Type the new name, then press ENTER to save your changes.
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 • EDIT SETTINGS 
You can use Nokia Phone Editor’s Settings application to view and edit a variety of phone settings, as well as configure how Phone 
Editor handles items you delete. The Settings application divides all of the settings into three properties tabs, as described below:

• General - used to specify how you want Phone Editor to process deleted items

• User - used to edit and store your user information

 • LAUNCH OTHER PC SUITE APPLICATIONS
The PC Editor navigation bar contains buttons that can be used to launch the other PC Suite applications. Use these buttons while 
in Phone Editor to launch PC Composer, PC Graphics, PC Sync, or Content Copier.
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8 Wireless modem setup for Nokia 6360 phone
Your phone can function as a wireless modem when connected to your PC via IR or cable. Once your phone is installed and 
configured properly, your phone works in conjunction with your existing data software, allowing you to connect to a corporate 
network, the Internet, or check e-mail wherever you are.

Important: This feature is available only if your service provider’s network supports circuit-switched data (CSD) digital data 
and fax services. A subscription to these services may also be necessary. Please check with your service provider prior to 
making or receiving digital data and fax calls.

Your PC’s hardware and virtual COM ports
Hardware resources between your computer’s physical COM ports and the infrared (IR) port often times are shared. Windows 
creates "virtual" COM ports to accommodate connections between your computer and infrared devices. If your infrared port uses 
COM1, your phone should be assigned to COM4; if your infrared port uses COM2, your phone should be assigned to COM5.

Important: If you wish to connect your phone and PC using IR, make sure that your PC’s IR port is functioning properly and 
that there are no device conflicts. Windows cannot detect your phone if the IR port is not functioning properly or conflicting 
with another device.

 • DOWNLOAD MODEM DRIVER
During the modem installation process, Windows looks for software specific to the new device being installed. The modem driver 
for your phone can be found in the 6360 product section of:

http://www.nokia.com/us

Since the Add New Hardware Wizard for all Windows operating systems searches the A:\ drive for device drivers first, Nokia 
recommends that you download this file and save it to a floppy diskette.

Note: If you choose to save the file to your hard drive, please make note of the path to the file as this information is required 
to complete the installation successfully. Depending on your operating system, locating this file on your hard drive may add 
additional steps to the installation process.

Choose the correct file
The Nokia PC downloads Web site contains the modem driver file needed for your phone:

• nok_tdma.inf 

This file is used when the connection method between your PC and phone is either the DLR-3P cable or IR.

Important: Windows 2000 Professional users: this file is necessary for cable installation only. If you wish to connect to your 
PC using IR, please see “Infrared and Windows 2000 Professional” on page 27 for more information on modem setup for your 
operating system.

Multiple modem installations
To provide yourself with the option of using either the DLR-3P or infrared to make your connection, you must perform the modem 
installation process twice (once for each connection method). 

Example: You have chosen IR as your connection method, yet you cannot find a flat work surface so you can align the IR ports of 
the two devices. You decide to connect using the DLR-3P cable instead. However, you cannot modify your existing IR modem 
configuration and change the serial connection to DLR-3P. To use the DLR-3P cable, you must already have an additional modem 
installation using the driver for the DLR-3P cable.

 • GETTING CONNECTED FOR THE FIRST TIME: DLR-3P CABLE (ALL WINDOWS VERSIONS)
1 Connect the DLR-3P cable to the serial port on the back of your laptop or desktop computer.

Note: If you are using a serial mouse, you need to purchase a RS232-to-PS/2 adapter and move your mouse to an existing 
PS/2 port, or purchase a PS/2 mouse. Check with your local computer dealer for these accessories.
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2 Connect the DLR-3P cable to your Nokia phone. Your phone displays a message 
indicating you have connected the data cable successfully, then returns to the Start 
screen. 

3 Click Start, point to Settings, then click Control Panel.

4 Double click the Modems or Phone and Modem Options control panel icon.

5 Click Add. (Windows 2000 users, please click the Modems tab, then click Add).

6  Select the Do not detect my modem... option, then click Next.

7 Click Other if asked about a PCMCIA modem (this screen may not 
appear on all systems), then click Next.

8 Insert the floppy diskette containing the .inf file in your drive now. 
Click the Have Disk button. Confirm that A:\ is the location of the 
nok_tdma.inf file, then click OK.

9 Select Nokia 6360 via Cable from the list of available choices, then 
click Next.

10 Select the COM port where the cable is attached (typically COM1), 
then click Next.

11 The Wizard indicates it has located the correct software for your 
phone.  Click Finish when Windows informs you that it has installed 
the device successfully.

12 Verify that your Nokia phone connected using the DLR-3P cable 
appears in the list of modems.

Complete the process by configuring your data software to work with the 
new infrared modem configuration. For more information, refer to 
“Configure your data and fax software” on page 29.

 • GETTING CONNECTED FOR THE FIRST TIME USING IR (WINDOWS 95, 98, AND ME)
Before you can make or receive digital data and fax calls, you must do the following:

1 Establish an infrared connection between your PC and your phone.

2 Install your phone as a wireless modem connected via infrared.

3 Configure your data software to use your phone as the active modem for data and fax calls.

Establish an infrared connection
The preferable distance between the two devices making an infrared connection is a range of three inches (7.5 cm) to three feet 
(.9 m) maximum. There must be no obstructions between the two devices, and the IR ports of the two devices must be pointing at 
each other.

ENABLE INFRARED COMMUNICATIONS ON YOUR PC AND PHONE
1 Double-click the Infrared icon in the Control Panel (Windows 95 and 98 only). Windows ME users, please go 

to step 4).
If this icon does not appear in the Control Panel, see “Install infrared support for Windows 95” on page 28. 

Tip: Windows 98 users can also launch the Infrared Monitor by double-clicking 
the Infrared Monitor icon in the system tray.

2 Click the Options tab, then select Enable infrared communication. Verify that the 
install software option for Plug and Play devices is selected.

3 Click Apply, then click the Status tab.

4 On your phone, press Menu, scroll to Infrared, then press Select.

5 Align the infrared ports of both devices. 

6 When a successful infrared connection has been made, the 
infrared monitor indicates that your phone has been found. 
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Modem installation
The Windows Add New Hardware Wizard launches immediately after 
the infrared monitor displays the connection status between phone 
and PC.

To complete modem installation:

1 Insert the floppy diskette containing the modem driver file when 
the Add New Hardware Wizard screen appears.

2 Click Next as necessary until Windows asks you for the location 
of the modem driver file.

3 Select A:\ or the floppy drive option (as necessary), then click 
Next.

4 The Wizard indicates it has located the correct software for your 
phone. Click Next to finalize the installation.

5 Click Finish when Windows informs you that it has installed the 
device successfully.

6 Verify that your Nokia phone connected via infrared appears in the list 
of modems.

Complete the process by configuring your data software to work with the 
new infrared modem configuration. For more information, refer to 
“Configure your data and fax software” on page 29.

 • INFRARED AND WINDOWS 2000 PROFESSIONAL
Microsoft redesigned its implementation of infrared services with the release of Windows 2000 Professional. To make an IR serial 
connection between IR-equipped Nokia phones and IR-equipped PCs running Windows 2000, you must download and install the 
following Microsoft software update: Security Update, August 19, 2001

Learn about Windows 2000 SRP1
Microsoft recently released the Windows 2000 Security Rollup Package 1 that provides a cumulative package of security updates 
offered since the release of Windows 2000 Service Pack 2 (SP2). Although the Security Update, August 19, 2001 software 
appears to be incorporated into SRP1, Nokia has determined that the Security Update, August 19, 2001 software is still required 
in addition to SRP1.

Locate Security Update, August 19, 2001
To locate the necessary software:

1 Point your Web browser to: http://www.microsoft.com/windows2000/downloads/

2 Using the site’s search utility, locate the Microsoft Knowledge Base article: 
Q252795.

3 Click the link to access Security Update, August 19, 2001, located in the list of 
search results.

4 Follow the instructions for downloading the software to your PC’s hard drive.

 • WINDOWS 2000 MODEM SETUP INSTRUCTIONS
1 Install the security update from Microsoft’s web site, then reboot your PC.

2 Enable IR communications on your phone (for more information on enabling IR on your phone, please refer to your phone’s 
user guide).

3 Align the infrared ports of your phone and PC. 
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When a successful infrared connection has been made, the infrared monitor indicates your phone has been found. Windows 2000 
installs your Nokia phone as Standard Modem over IR link. 

Confirm successful installation of your phone via the Phone and Modem Options Control Panel. Use this new device with your 
data application (example: Dial-up Networking).

 • GETTING CONNECTED FOR THE FIRST TIME: IR (WINDOWS XP HOME AND PROFESSIONAL)
Wireless modem support using IR with Windows XP is similar to that of Windows 2000 with the security update applied. To install 
your phone as a wireless modem using infrared, please see “Infrared and Windows 2000 Professional” on page 27, but begin with 
step #2.

 • IR AND WINDOWS NT WORKSTATION 4.0
Microsoft does not support infrared for Windows NT Workstation 4.0. However, the manufacturer of your laptop or desktop PC may 
offer their own support of IR for Windows NT. Check with the manufacturer of your hardware for more information.

 • INSTALL INFRARED SUPPORT FOR WINDOWS 95
If you have the first releases of Windows 95, you may not have the most recent files to support infrared. You may need to download 
the Windows 95 Infrared Support version 2.0. This software can be found in the software download section of Microsoft’s web site:

http://www.microsoft.com

TO DETERMINE WHETHER YOU HAVE THE MOST RECENT WINDOWS 95 INFRARED SUPPORT SOFTWARE:
1 Double-click Add/remove programs in the Control Panel.

2 Scroll through the list of installed applications to find Infrared Support for Windows 95 version 2.0.

3 If this software is not listed, proceed to Microsoft’s web site. Download and install the necessary files (w95ir.exe). 

Note: For more information on installation and configuration of Infrared Support for Windows 95 version 2.0, please refer 
to the Readme files that accompany the update software.
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9 Configure your data and fax software
Before you can use your phone to send and receive digital data and fax calls, you must configure your data software so that it uses 
your phone rather than your existing modem. You may consider creating a separate set of dialing properties to use when your phone 
is connected to your computer, rather than changing any existing settings.

The following pages are designed to help you configure some of the more popular applications to be used with your Nokia phone

 • OBSERVE THE FOLLOWING BEFORE MAKING OR RECEIVING DIGITAL DATA OR FAX CALLS
• You must subscribe to digital data and fax services with your service provider.

• Your phone must be powered up, and you must be in a digital network. Do not switch the phone on when wireless phone use 
is prohibited or when it may cause interference or danger. 

• Your PC’s infrared port must be configured properly (internal or external port).

• You must establish a connection connection between your PC and your phone.

• Your data software must be running and configured to recognize your Nokia phone as the active modem.

 • CONFIGURE YOUR DATA SOFTWARE
Before you can use your phone as a wireless modem, you must configure your data software so that it uses your phone as the active 
modem (rather than your existing modem). The following pages are designed to help you configure some of the more popular 
applications for digital data and fax calls.

 • USE MICROSOFT DIAL-UP NETWORKING
You may be using Microsoft’s Dial-up Networking feature to connect to your Internet service provider, or to make a remote 
connection to your corporate network (including corporate e-mail server using Microsoft Outlook, or Lotus cc:Mail).

Rather than altering the existing configurations you use when dialing with your existing modem, consider creating a new 
connection exclusively for use with your Nokia phone (as detailed below).

GATHER CONFIGURATION INFORMATION
You need the phone number for your Internet service provider or for your company’s remote access server. When testing the new 
connection, you also need your user name and password.

Create a new connection
1 Double-click the My Computer icon, then double-click the Dial-up Networking folder (Windows 2000 and Windows ME users: 

Click Start, point to Settings, then click Dial-up Networking).

2 Double-click the Make New Connection icon.

3 Type a name for your new connection (example: Internet-Nokia phone). 

4 Click the drop-down arrow and select your Nokia phone as the 
modem to use, then click Next.

5 Enter the area code, telephone number, and country code (if 
necessary), then click Next.

6 Click Finish to save the new configuration in your Dial-up 
Networking folder.

7 Make sure to configure any necessary network parameters for 
this connection prior to dialing (IP address of DNS or WINS, 
etc.).

Note: For more information on configuring your network connection, please consult your Internet service provider or your 
company’s help desk.

Connect to the network
Make sure you establish a connection between your phone and PC (using the DLR-3P cable or IR) before making a digital data call.

1 Double-click the new connection (example: Internet-Nokia phone).
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2 Enter your user name and password, then click Connect.

3 Your phone displays Connecting... while establishing a connection. Once a successful connection has been made, Data call 
appears on the phone’s screen. 

Note: Your Windows operating system displays its normal series of messages while the connection is being established and 
verified.

Note: Your wireless service provider must support digital data for this feature to work. Contact your service provider to verify 
that this service is available in your area.

Notes about data calls
• Do not terminate digital data/fax calls by pressing your phone’s key. This action may cause your data application to 

lock up temporarily and could cause loss of data.

• Data calls cannot be initiated using your phone’s keypad. All data calls must be initiated using the data software.

• Any touch tones (DTMF tones) needed for calling cards, special long-distance access numbers, etc. must be programmed into 
the dialing string.

 • OTHER DATA APPLICATIONS
There are several other types of telecommunications applications that can be used with your Nokia phone and your computer. Some 
of these include:

• Terminal Programs - used to connect to BBS services (bulletin board system) and mainframe or mini-mainframe 
computers. Quarterdeck’s Procomm Plus, Microsoft HyperTerminal, Microsoft Works (Communications Module), R-Link, 
and P-Term are just a few examples of this type of program.

• Remote Administration - used to remotely access your home or office computer for file sharing or remote control. 
Symantec’s PCAnywhere, McAfee’s Remote Desktop and Reach Out, Farallon’s Timbuktu, Claris’ Apple Remote Access, and 
Attachmate’s EXTRA! are a few examples of this type of program.

• On-line Services - used to access the Internet, or discussion and information forums within the service. On-line services 
provide their own proprietary software interface for accessing their service. America Online, CompuServe, MSN (Microsoft 
Network), and Prodigy are just a few on-line service providers that use their own proprietary software.

Important: These examples are provided for your information only. Nokia does not endorse or provide support for any of the 
above applications or services.

REMINDERS!
Before you can use your Nokia phone with ANY data program, you must first do the following:

• Establish a connection between your phone and PC using either IR or the DLR-3P cable.

• Use the data program’s setup menu to set your Nokia phone as the active modem. Consult the program’s User Guide or Help 
menu for more information.

• Review the information, “Requirements for digital data and fax calls” on page 1.

 • FOR AMERICA ONLINE (AOL) USERS
Your America Online software can be configured to use your Nokia 
phone as a wireless modem.

MODEM SETUP
 To add your Nokia phone as a new modem to AOL’s connection 
setup:

1 From the Sign On screen, click SETUP.

2 Click Expert Setup, then click the Devices tab.

3 Click the Expert Add button.

4 Verify that Modem (telephone line connection) is selected as 
the type of connection device you want to add, then click Next.

5 Select the generic modem option (example: Standard (Hayes 
Compatible)) from the list of modems.
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6 Select the COM port assigned to your PC’s infrared COM port, or the hardware COM port where the DLR-3P is connected.

7 Set the port speed to 14400 bps, then click OK.

Modify “Locations”
Now that your Nokia phone is configured for use by the AOL software, you need to modify 
your Locations settings to use your Nokia phone as the active modem.

LOCATIONS SETUP
To modify an existing location:

1 From the Connection Setup screen, click the Locations tab.

2 Double-click the number for the location you wish to use with your Nokia phone.

3 Click the Connect using drop-down arrow, then click Modem: Standard (Hayes compatible) on COMnn (where nn is COM 
port for your PC).

4 Click the Speed drop-down arrow, then click 1400 bps.

5 Click OK to confirm your changes, then click Close to return to the Sign On screen.

 • CONFIGURING YOUR FAX SOFTWARE
Before you can use your phone to send and receive fax calls, you must configure your fax software so that it uses your phone as 
the active modem (rather than your existing modem). 

Many of the most popular fax programs should support multiple modems connected to a PC or laptop computer, including 
Symantec WinFax Pro, Smith Micro Software HotFax (version 3.02 or newer), Castelle FaxPress, etc.

Note: Data or fax calls using your Nokia phone are possible only if your service provider supports digital data and fax service. 
You may be required to subscribe to these services. Check with your service provider before attempting to send or receive faxes.

Select the correct modem
Each fax application typically has a setup menu that can be used to alter 
the settings for your modem, as well as define how and when calls are to 
be received (for example: immediately, on the third ring, etc.). This menu 
may also provide you with a list of available modems that you can use when 
sending and receiving fax calls. 

Use your fax program’s settings menu to select your Nokia phone as the 
active fax modem. 

Hardware setup
Use the modem properties dialog box of your fax software to confirm the 
following settings:

• Communications port - COMn (where n= the COM port number 
assigned to your phone)

• Initialization - 19200 bps

• Modem type - Class 2.0

• Flow control - Hardware
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Important: The following instructions are based on Palm OS (operating system) software 3.3 and those devices that can run 
this version of the operating system (or newer versions). For more information, please visit:

 http://www.palmos.com/ 

 • LEARN ABOUT YOUR PHONE AS A WIRELESS MODEM
It is possible to make a serial connection between your phone and your PalmOS device and use it as a wireless modem to perform 
HotSync operations with your PC.

In addition, third-party software is also available that allows you to browse the Web, send and receive faxes, and send or receive 
e-mail directly to your PalmOS device. Check your owners manual or the PalmOS web site for more information on third-party 
software. 

Important: To access the Internet, you must have an existing dial-up account with a full-service Internet provider or dial-up 
access to a corporate network. Connection to on-line services such as CompuServe or Prodigy are not available at this time. 

Note: America Online provides a software program that allows you to check your AOL E-mail from your handheld device. 
For more information, type AOL keyword: PDA.

 • CONNECTION OPTIONS
You can create a connection between your PalmOS device and your phone using either the DLR-3P cable or IR.

DLR-3P cable connection
Most PalmOS devices come with a serial cable used to connect your device with a desktop PC or laptop computer. This cable has 
either a USB male or an RS-232C female connection at one end and a special connector that plugs into the handheld device (either 
directly or via a docking cradle).

• If your PalmOS device’s serial cable has the standard RS-232C connector, you need only the DAN-1 (null modem adapter with 
RS-232C connectors on each end) supplied in the DLR-3P accessory sales package.

• If your PalmOS device’s serial cable has a USB connector, you need to purchase an additional serial cable with the standard 
RS-232C connector. The manufacturer of your PalmOS device sells this cable as an accessory. You also need the DAN-1 (null 
modem adapter with RS-232C connectors on each end) supplied in this sales package.

DAN-1
This adapter is used to join your device’s serial cable to the DLR-3P cable (as shown in the figure below). 

Note: Macintosh PalmOS device users do not need to use the RS232 - DB9 adapter.

Important: If you are unable to order the RS-232C serial cable as an accessory, you may be able to purchase a USB-to-RS-
232C adapter. This device may be available at your local computer retailer, or via the Internet. Or you may consider using IR 
as your connection method.

IR (infrared) connection
Your PalmOS device should be equipped with an infrared port. You may find it more convenient to connect your phone and PalmOS 
device using IR, especially if you prefer to leave your serial cable or docking cradle attached to your PC.

Before dialing, make sure you enable infrared communications on your PalmOS device, then align the IR ports of the 2 devices. The 
preferable distance between the two devices in an infrared connection is a range of three inches to three feet maximum. There 
must be no obstructions between the two devices and the IR ports of the two devices have to be pointing at each other.

Your Nokia phone is a Class 1 Laser Product.

DAN-1
null modem adapter

DLR-3P
cable

Palm
device’s
cable
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 • CONNECTIONS PREFERENCES
Before you can make data calls using your PalmOS device and your Nokia phone as a wireless 
modem, you need to create a new connection device in the Connections preferences folder.

1 Tap the Applications icon, then tap Prefs

2 Tap the Categories drop-down menu, then tap Connection.

3 Tap New. Enter the name of the new connection device (example: Nokia). 

4 Click the Connection Method drop-down arrow, then click either Serial to Modem (for DLR-3P 
connection) or IrCOMM to Modem (for IR connection).

5 Click Details. Set speed to 19,200 bps and flow control to Automatic. Click OK when finished, then click OK to close the Edit 
window.

6 Your new Nokia phone configuration should now appear in the list of Connection options, and is available to all applications 
that support a modem connection.

 • MAKE A DIAL-UP CONNECTION
Once you have a modem configuration for your Nokia phone, you can use that configuration with any existing TCP/IP or network 
preferences, as well as any stand-alone 3rd party E-mail, Web browser, or fax programs. 

Data connection
Once your Nokia phone is configured as a wireless modem for use with your PalmOS device, you need to modify your existing 
Windows RAS configuration to use your phone as the active modem.

1 Tap the Applications icon, then tap Prefs.

2 Tap the Categories drop-down menu, then tap Network.

3 Tap the Services drop-down arrow, then tap Windows RAS.

4 Tap the Connection drop-down arrow, then tap the name of the connection device (example: Nokia).

Your existing Windows RAS connection is now configured to dial using your Nokia phone as a wireless modem.

Before you make a digital data call
Before initiating the data call from your PalmOS device, make sure you enable infrared communications on your phone, then align 
the infrared ports of the two devices. If you are using the DLR-3P for the connection, make sure the cable is connected properly to 
both the phone and your computer’s COM port.

Please also see “Requirements for digital data and fax calls” on page 1.
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 • LEARN ABOUT YOUR PHONE AS A WIRELESS MODEM
You can use your Nokia phone as a wireless modem with Pocket PC devices, then use these devices to check e-mail or browse the 
Web.

You may also be able to send and receive faxes from your Pocket PC device. However, this may require additional software from 
another manufacturer. Check your device’s user guide, Web site, or the Microsoft Pocket PC Web site for more information on available 
software: 

http://www.microsoft.com/mobile

Important: To access the Internet, you must have an existing dial-up account with a full-service Internet provider or dial-
up access to a corporate network. Connection to online services such as CompuServe and Prodigy is not available at this time. 

Note: America Online offers a software program that allows you to check your AOL e-mail from your handheld device. For 
more information, go to keyword: PDA.

 • CONNECTION OPTIONS
You can create a connection between your PocketPC device and your phone using either the DLR-3P cable or IR.

DLR-3P cable connection
Most PocketPC devices come with a serial cable used to connect your device with a desktop PC or laptop computer. This cable has 
either a USB male connection or an RS-232C female connection at one end, and a special connector that plugs into the handheld 
device (either directly or via a docking cradle).

• If your PocketPC device’s serial cable has the standard RS-232C connector, you need only the DAN-1 (null modem adapter with 
RS-232C connectors on each end) supplied in the DLR-3P accessory sales package.

• If your PocketPC device’s serial cable has a USB connector, you need to purchase an additional serial cable with the standard 
RS-232C connector. The manufacturer of your PocketPC device sells this cable as an accessory. You also need the DAN-1 (null 
modem adapter with RS-232C connectors on each end) supplied in this sales package.

DAN-1
This adapter is used to join your device’s serial cable to the DLR-3P cable (as shown in the figure below). 

Important: If you are unable to order the RS-232C serial cable as an accessory, you may be able to purchase a USB-to-RS-
232C adapter. This device may be available at your local computer retailer, or via the Internet. Or you may consider using IR 
as your connection method.

IR (infrared) connection
Your PocketPC device should be equipped with an infrared port. You may find it more convenient to connect your phone and 
PocketPC device using IR, especially if you prefer to leave your serial cable or docking cradle attached to your PC.

Before dialing, make sure you enable infrared communications on your PocketPC device, then align the IR ports of the 2 devices. 
The preferable distance between the two devices in an infrared connection is a range of three inches to three feet maximum. There 
must be no obstructions between the two devices and the IR ports of the two devices have to be pointing at each other.

Your Nokia phone is a Class 1 Laser Product.

DLR-3P
cable

Pocket PC’s
serial cable

DAN-1
null modem adapter
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 • CONFIGURE A MODEM CONNECTION
The procedure for creating a new modem connection for use with your Nokia phone is similar to that found in the various Windows 
desktop operating systems. However, before you can configure your PocketPC for a digital data call, you need to obtain the required 
setup information from your ISP or corporate network’s Helpdesk.

Important: You may need to first disable your Pocket PC’s option that automatically begins synchronization when an 
infrared connection is detected. For more information on this task, please consult your device’s user guide.

Creating a modem connection
To create a new modem connection to your Internet service provider or corporate network:

1 Tap the Start icon  , then tap Settings.

2 Tap the Connections tab, then tap Modem.

3 Tap New Connection, then enter a name for the connection (example: Internet-Nokia phone). 

4 Click the modem selection drop-down arrow, then select the IrCOMM or Generic IrDA option for IR connections, or select 
Hayes Compatible on COM1 when using the DLR-3P for the connection.

5 Tap Advanced to access additional configuration properties for Port Settings, TCP/IP, and Name Servers (if required by your 
corporate network or ISP).

6 Tap OK to close the Advanced properties window, then tap Next.

7 Enter the area code (if necessary) and phone number, then click Next.

8 Tap Wait for dialtone to deselect this option, then tap Finish.

 Your new dialing configuration is now visible in the Modem Connections list.
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You may need to click the Dialing tab and modify the way Pocket PC dials local, long distance, and international numbers. For more 
information on dialing patterns, consult your handheld device’s documentation.

Use your new modem connection
To connect to your Internet service provider or corporate network:

1 Tap the Start icon , then tap Programs.

2 Tap Connections, then tap your new modem connection (example: Internet-Nokia phone).

3 Enter your user name, password, and domain (if necessary).

4 Click Connect. When you have successfully logged on to the network, the Pocket PC’s status screen will show the message 
Device Connected.

5 Launch your browser or e-mail application. 

Note: For information on how to configure the Pocket PC Web browser or e-mail software, please consult your device’s 
documentation.

Before you make a digital data call
Before initiating the data call from your Pocket PC device, make sure you enable infrared communications on your phone, then 
align the infrared ports of the two devices. If you are using the DLR-3P for the connection, make sure the cable is connected 
properly to both the phone and your computer’s COM port.

Please also see “Requirements for digital data and fax calls” on page 1.
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